
Customizing the Way 
You Work

Introduction

No description of Adobe Photoshop would be complete with-
out that well known, but little utilized area called Preferences.
Photoshop preferences serve several purposes. They help
customize the program to your particular designing style, and
they help you utilize available computer resources to
increase the overall performance of the program. 

By modifying File Handling preferences, such as append-
ing a file extension on the file, or being asked when saving a
layered TIFF file, you can streamline file saving process. In
addition, you can change the way your cursors look. For
example, do you want your paintbrush to look like a paint-
brush when you paint, do you prefer a precession crosshair
or the actual brush size shape, or the shape with a crosshair?

As you use Photoshop, you'll come to realize the impor-
tance of working with units and rulers. Precision is the name
of the game when you are working with images. What about
the color of your guides, grids, and slices? No big deal, you
say. Well, if you've every tried viewing a blue guide against a
blue-sky image, you know exactly why color is important. By
working through preferences such as Image Cache, Scratch
Disks, and RAM Memory, speed increases of up to 20 percent
can be achieved. 

In addition, customizing the program, helps make you
more comfortable, and studies show that the more comfort-
able you are as a designer the better your designs. Plus,
being comfortable allows you to work faster, and that means
you'll accomplish more in the same amount of time. What
does setting up preferences do for you? They make
Photoshop run faster (up to 20 percent), you work more effi-
ciently, and your designs are better. That's a pretty good com-
bination. Photoshop doesn't give you preferences to confuse
you, but to give you choices, and those choices give you con-
trol.
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What You’ll Do

Optimize Photoshop

Set General Preferences

Modify File Handling Preferences

Work with Interface Preferences

Work with Cursors Preferences

Control Transparency & Gamut
Preferences

Work with Units & Rulers

Work with Guides, Grid, Slices & Count

Select Plug-Ins

Select Scratch Disks

Allocate Memory & Image Cache

Work with Type

Manage Libraries with the 
Preset Manager

Customize the Workspace

Define Shortcut Keys

Create a Customized User Interface

Use Drawing Tablets
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Optimizing Photoshop

Photoshop is a powerful program, and as
such, requires a tremendous amount of com-
puting power. When working on large docu-
ments, a poorly optimized Photoshop will
translate into long wait times. That's the bad
news if you have a deadline to meet. The
good news is that Photoshop can be config-
ured to run more efficiently. To optimize
Photoshop, click the Edit (Win) or Photoshop
(Mac) menu, point to Preferences, and then
click Performance. The Performance prefer-
ences dialog box contain options that will
help increase the performance of Photoshop.

History States
History States control the number of undos
available. In fact, you can have up to 1000
undos (ever wonder who would make so
many mistakes that they would need 1000
undos?). Unfortunately, increasing the number

of History States will ultimately increase the
amount of RAM Photoshop uses to manage
the History palette. Assigning more RAM
memory to manage History means less
memory for Photoshop to perform normal
operations, and will reduce the performance
of the program. If you are experiencing
slow performance problems, lowering the
number of History States frees up more
RAM, and permits Photoshop to operate
more efficiently.

Scratch Disk
When your computer doesn’t have enough
RAM to perform an operation, Photoshop
uses free space on any available drive,
known as a Scratch Disk. Photoshop
requires 5 times the working size of the file
in contiguous hard drive space. For exam-
ple, if the working size of your file is 100MB, 

History States
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you will need 500MB of contiguous hard drive
space, or you will receive an error message:
Out of Scratch Disk Space (I hate it when that
happens). Using additional hard drives gives
Photoshop the ability to divide the processing
load and increase performance. Photoshop
detects and displays all available internal
disks in the Preferences dialog box. Scratch
disks must be physically attached to your
computer (avoid networks and removable
media, such as zip drives, or rewriteable CDs
or DVDs). For maximum speed, avoid USB,
and use 4 or 6-pin Firewire drives. Benchmark
tests show Firewire drives provide up to a 20
percent speed improvement when used as
Scratch Disks. Think of saving one hour out of
every five, or one full day out of every five.
That's not too bad. For best results, select a
scratch disk on a different drive than the one
used for virtual memory or any large files
you’re editing. 

Memory & Image Cache
Photoshop functions in RAM memory (actually
all applications work within RAM). To run effi-
ciently, Photoshop requires five times the
working size of the open document in avail-
able memory (some tests indicate 6 to 8
times). Strictly speaking, the more RAM mem-
ory you can assign to Photoshop, the more
efficient the program operates, especially
when opening large document.

RAM memory usage is determined by the
working size of the document, not its open
size. As you work on a document, you will
eventually add additional layers to separate
and control elements of the image. As you add
these new layers, the working size of the file
increases.

RAM memory allocation

Available Scratch Disks
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Photoshop's General preferences help you configure some of the more
common features of the program. Image quality settings, as well as the
new History log are setup in General preferences. Other options, such
as showing tool tips, beeping when an operation is finished, and using
Smart Quotes, can all be turned on or off in the options area. The
History Log lets you save all the History States performed on a particu-
lar document. For example, when you open an image, all the adjust-
ments and actions performed are saved in a text file. This gives you
access to valuable information, and lets you reproduce the steps per-
formed on one image, to correct the contents of another. You can also
change the size of the small font text on the Options bar, palettes, and
tool tips.

Setting General
Preferences

Work with General Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click General.

Click the Color Picker list arrow,
and then select Adobe or another
operating system (Windows or
Macintosh).

Click the Image Interpolation list
arrow, and then select Nearest
Neighbor (Faster), Bilinear, or one
of the Bicubic options.

Click the UI Font Size list arrow,
and then select a size for the user
interface fonts.

The change takes effect the next
time you start Photoshop.

Select the various options you
want to use:

◆ Automatically Launch Bridge.
Automatically launches the
Bridge in the background every
time Photoshop is launched.

◆ Auto-Update Open Documents.
Creates a link between the
open image and the image file
on disk.

◆ Beep When Done. Sounds
when an operation is complete.
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◆ Dynamic Color Sliders. Previews
color effects within the slider
bars.

◆ Export Clipboard. Transfers a
copied image to the operating
systems clipboard.

◆ Use Shift Key For Tool Switch.
Allows you to use the keyboard
shortcut when two tools share
the same slot in the toolbox.

◆ Resize Image During Paste/
Place. Allows you to resize an
image during a Paste or Place.

◆ Zoom Resizes Windows. Forces
the image window to resize
when zoom is selected.

◆ Zoom With Scroll Wheel.
Determines whether zooming or
scrolling is the default operation
of the scroll wheel.

Select the History Log options you
want to use.

Click OK.8

7
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6
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Sooner or later, you'll have to save the file (document) you've created
in Photoshop. The final output of any document is contained within a
specific file format such as tif, eps, jpg, or even bmp. In fact, Photoshop
lets you save files using over 18 different formats. The File Handling
preferences provide several options that modify what information is
saved with a file. Image previews are typically very small; add very little
to the file size of the saved document. Once saved you will want to
open, print, and possibly even modify the document using other image-
editing applications. The File compatibility options help you save a file
that will be transportable to other applications. 

Modifying File
Handling
Preferences

Work with File Handling Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click File Handling.

Select the File Saving Options you
want to use:

◆ Image Previews. Select Always
Save, Never Save, or Ask When
Saving.

◆ Icon. Saves previews of the
images (Mac).

◆ Full Size. Saves full-size
previews for use as FPO (For
Placement Only) objects in
Desktop layout programs
(Mac).

◆ Mac Thumbnail. Saves
previews viewable when using
the Mac File Open command
(Mac).

◆ Win Thumbnail. Saves
previews viewable when using
the Win File Open command
(Mac).

◆ Append File Extension. Lets
you choose whether to append
the file extension (Mac).

◆ Use Lower Case. Choose to
have upper or lower case
extensions.

3
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Select the File Compatibility options
you want to use:

◆ Prefer Adobe Camera Raw for
JPEG Files (New!). Open JPEG
files in Camera Raw.

◆ Prefer Adobe Camera Raw for
Supported Raw Files (New!).
Open Raw supported files in
Camera Raw.

◆ Ignore EXIF Profile Tag. Ignores
color space metadata attached
to digital camera images.

◆ Ask Before Saving Layered TIFF
Files. Lets you create multi-
layered documents, and then
save them using the TIFF format. 

This is a distinct advantage
when you need to use multi-
layered files and you don't want
to save them using Photoshop's
proprietary format .psd.

◆ Enable Large Document Format.
Lets you create and save large
files (up to 6 GB).

◆ Maximize PSD File
Compatibility. Lets you save
.psd files that can be opened in
earlier versions of the program.

Select the Enable Version Cue
check box to save files compatible
with Adobe Version Cue.

Enter the number of files (up to 30)
to keep in the Recent File List box.

Click OK.7
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See Also
See “Understanding File Formats” on
page 381 for information on some of the
various file formats available in
Photoshop.
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Working with the Interface preferences gives you control over whether
Photoshop displays or hides user interface features. You can display
some user interface elements in color. For example, you can show the
Toolbar icon in color or grayscale (New!), show channels in color, or
show selected menu items in user-defined colors. Interface prefer-
ences also allows you to shows labels when your cursor is placed over
an option, automatically collapse icon palettes when you click away
(New!), and remember palette locations for use next time.

Working with
Interface Preferences

Work with Interface Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Interface.

Select the Interface options you
want to use:

◆ Use Grayscale Toolbar Icon.
Shows the toolbar icon in
grayscale or color (New!).

◆ Show Channels In Color.
Allows you to view channels in
the Channels palette in color. 

For example, the red channel
displays using shades of red,
the green channel using
shades of green, and the blue
channel using shades of blue.
When this option is not
selected, color channels
display, using shades of gray
(does not affect printing).

◆ Show Menu Colors. Displays
selected menu items in user-
defined colors.

◆ Show Tool Tips. Shows labels
when your cursor is placed
over an option.

◆ Auto-Collapse Icon Palettes
(New!). Automatically collapse
icon palettes when you click
away.

◆ Remember Palette Locations.
Saves the palette locations.

Click OK.4

3

2
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We communicate with Photoshop using various devices, such as a
drawing table, mouse, touch screen, track pad, and a keyboard.
Photoshop communicates with us using visual cues, the most promi-
nent one is the shape of the cursor. For example, when a cursor looks
like an I-beam, this typically means it's time to enter text, or when the
cursor looks like a magnifying glass, clicking on the image expands the
view size. Working with the Cursors preferences gives you control over
how Photoshop communicates with you. 

Working with Cursors
Preferences

Work with Cursors Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Cursors.

Select the Painting Cursors
options you want to use:

◆ Standard. Painting cursors
appear as their toolbox buttons. 

◆ Precise. Painting cursors
appear as cross-hairs.

◆ Normal Brush Tip. Painting
cursors appear with the shape
of the active brush tip.

◆ Full Size Brush Tip. Shows the
full size of the brush tip,
including feathered edges.

◆ Show Crosshair In Brush Tip.
Displays a crosshair in the
center of the brush tip.

Select the Other Cursors options
you want to use:

◆ Standard. Painting cursors
appear as their toolbox buttons. 

◆ Precise. Painting cursors
appear as cross-hairs.

Click OK.5

4
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2
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For Your Information

Toggling Between Precise and Standard Tools

Pressing the Cap Lock key while using a painting cursor, toggles the
tool between the precise and brush size options, and pressing the Cap
Lock key when using any other cursor, toggles between standard and
precise.

4
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The Transparency & Gamut preferences control how Photoshop dis-
plays transparent areas of a document (commonly called the table-
cloth), as well as the color and opacity of areas of an image that fall
outside of the CMYK (Cyan, Magenta, Yellow, Black), color mode. It's
important to understand that transparency in Photoshop does not
always translate into transparency, after you save the file. For example,
the JPEG format is used primarily for images saved for the Internet, and
does not support transparency. When you save the file, Photoshop will
fill the transparent areas of the image with a matte color (default
white). In addition, the Gamut Warning mask is used because a monitor
displaying color information using RGB, and has more saturation values
than a 4-color press (CMYK). Using new inks and spot colors can some-
times overcome an out-of-gamut color. For transparency it's important
to remember that unless you're printing the document directly in
Photoshop, it's the format that determines if the transparent areas will
be saved, and the Gamut Warning is there to warn you of any areas
that may not be saved. 

Controlling
Transparency
& Gamut Preferences

Control Transparency 
& Gamut Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Transparency & Gamut.

Select the Transparency Settings
options you want to use:

◆ Grid Size. Allows you to select
a transparency grid size. 

◆ Grid Colors. Allows you to
choose the color scheme for
the transparency grid.

3
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Select the Gamut Warning options
you want to use:

◆ Color. Choose a color to mask
areas of an image that move
out of the CMYK color space.

◆ Opacity. Enter a value from 0 to
100 percent. 

Opacity determines how much
of the Color Overlay masks the
original image pixels.

For example, if you choose the
color gray, and an opacity of
100 percent, areas of an image
that fall outside of the CMYK
color space will be masked
with gray.

Click OK.

IMPORTANT To activate the
gamut warning option, open a
document in Photoshop, click the
View menu, and then click Gamut
Warning. Out of Gamut areas of
the image will display with the
color and opacity chosen in the
Transparency & Gamut
preferences.

5
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While changing the measurable units and rulers do not affect output
quality, they do help to measure information in a document consistent
with the specific output device. Ruler units give you precise information
on the width and height of the active document. The column size meas-
urements provide information that Photoshop needs to create docu-
ments in the column and width of newspapers, magazines, brochures,
etc. The Preset Resolutions lets you select specific resolution values
for creating new documents. Insert the values you'll use most often in
the creation of a new Photoshop document. 

Working with Units 
& Rulers

Work with Units & Rulers
Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Units & Rulers.

Select the Units options you want
to use:

◆ Rulers. Sets a default
measuring system for the 
Ruler bar. 

For example, pixels would be
most common for images
displayed on a monitor, and
pica or inches most common
for output to press or printer. 

◆ Type. Sets to measure type with
a default value of points or
millimeters.

3
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Did You Know?
You can switch between ruler meas-
urements without going to prefer-
ences. To change the default
measurement system of the Ruler bar,
simply move into the Ruler bar, and
then right-click your mouse. A list of
available measurement options will be
instantly available.

3
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Select the Column Size settings
you want to use:

◆ Width. Choose a measurement
system and numerical value for
column width.

◆ Gutter. Choose a measurement
system and numerical value for
gutter (the space between the
columns).

When you choose a
measurement system (points,
inches, or cm), Photoshop
changes the value to
correspond to the type of
measurement system. 

Select the New Document Preset
Resolutions settings you want to
use:

◆ Print Resolution. Select a print
resolution and measurement
value for default printing.

◆ Screen Resolution. Select a
print resolution and
measurement value for default
screen display. 

Click the Postscript or Traditional
option measuring systems for
Photoshop's type tool (Postscript
is the most widely used).

Click OK.7
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The Guides, Grid, Slices & Count preferences help keep a multi-layered
document in proper order. For example, lining up buttons on a Web
interface, or making sure specific design elements are exactly in place
within the document window. The Guides option lets you select the
color and style of the guides placed within a Photoshop document.
Guides are placed within the image by dragging them from the horizon-
tal or vertical Ruler bars in the active document. The Grid options let
you decide on a color, style, and layout for Photoshop's grid system.
The Slices option defines the visible color of a slice, and whether
Photoshop displays a number value for each slice. The Count option
specifies color used to display the count number when you count
objects in an image using the Count tool (Extended) (New!).

Working with Guides,
Grid, Slices & Count

Work with Guides, Grid, Slices
& Count Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Guides, Grid, Slices & Count.

Select the Guides options you
want to use:

◆ Color. Select a default color for
displaying guides. 

◆ Style. Select a default (Lines or
Dashed) for displaying
guidelines.

Select the Smart Guides options
you want to use:

◆ Color. Select a color for use
with Smart Guides. 

4
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Did You Know?
You can change a horizontal guide
into a vertical guide, and vise versa.
Move into the Ruler bar and drag guide
into the document window. Before
releasing the mouse, hold down 
the Alt (Win) or Option (Mac) key. 
The guide automatically switches
directions.

3
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Select the Grid options you want
to use:

◆ Color. Select a default color for
displaying grids. 

◆ Style. Select a default style
(Lines, Dashed Lines, or Dots)
for displaying the grid.

◆ Gridline Every. Enter a value for
how often the grid lines appear
within the active document.

◆ Subdivisions. Enter a value for
how many subdivisions (lines)
appear between each main
gridline.

Select the Slices options you want
to use:

◆ Line Color. Select a default line
color for displaying document
slices.

◆ Show Slice Numbers. Select
the check box to display a
number for each slice in the
upper-left corner of the slice.

IMPORTANT When you select
a line color, choose a color that is
different than the guide and grid
line colors. That way you can
easily identify grids and guides for
user-created lines.

Select a color for use with the
Count tool (New!).

Click OK.8
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Did You Know?
You can change colors choices for
Guide, Grid, Slices & Count. Not satis-
fied with the color choices offered by
the color and style menus. Click on the
Color boxes located on the right side of
the Preferences dialog box, and select
any color from the Color Picker.

8
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The Plug-Ins preferences give you the ability to organize your plug-ins
by saving them in one or more folders. These additional folders are typ-
ically used to hold additional third-party plug-ins. When selected, plug-
ins contained within the folder will be available from Photoshop's
Filters menu. Organizing your plug-ins into folders helps keep your proj-
ect focused and reduces the clutter of plug-ins when you select the
Filter menu. 

Selecting Plug-Ins

Work with Plug-Ins Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Plug-Ins.

Select the Additional Plug-Ins
Folder check box to store
additional plug-in.

IMPORTANT The first time you
select this option, Photoshop asks
you where to store the plug-ins.
The next time you want to store
plug-ins or add additional plug-ins,
click Choose.

If necessary, click Choose to
identify the folder where you want
to store plug-ins, and then click
OK.

Enter in your Legacy Photoshop
Serial Number.

Some third-party plug-ins require
access to Photoshop's old style
Serial Number. If you've been
upgrading Photoshop, and you
have the old style serial number
(starts with PS) enter that number
in the Legacy input box.

Click OK.6
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Selecting Scratch
Disks

Work with Scratch Disks
Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Performance.

Select the check box next to the
scratch disk you want to use or
clear the check box to remove it. 

IMPORTANT Photoshop holds
scratch disk space as long as the
application is open. To delete
scratch disk space you must close
Photoshop.

Click OK.4
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The Performance preferences are available to help you get the best
performance out of your computer, by letting you choose one or more
hard drive for scratch operations. When your computer doesn’t have
enough RAM to perform an operation, Photoshop uses free space on
any available drive, known as a Scratch Disk. Photoshop runs faster
when you divide the Scratch Disk workload. Scratch operations are
performed on your hard drive, and take place when Photoshop is using
one of its many filters and adjustments. Photoshop detects and displays
all available internal disks in the Performance preferences dialog box,
where you can select the disks you want. By assigning additional hard
drives to the task, you speed up Photoshop's overall performance.
Scratch Disk changes take effect the next time you start Photoshop.

3



68

The Memory & Image Cache preferences give you control over how
much RAM memory is assigned to Photoshop, and how much memory
is allocated to screen draws (Image Cache). Photoshop, being a high-
performance application, requires a fairly large amount of RAM mem-
ory. Adjusting these options can help increase Photoshop's overall
speed performance. Photoshop uses many things that effect RAM
memory: History States, Undo, Clipboard, and Cache. When you modify
the cache settings, you are increasing or decreasing the amount of
RAM Photoshop uses for various tasks. Experimentation is the key
here. Try different settings and record Photoshop's performance. By
fine-tuning Photoshop's engine, you increase it's overall speed, and
you'll get more design miles to the gallon. 

Allocating Memory &
Image Cache

Allocate Memory & Image
Cache Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Performance.

Select the History & Cache options
you want to use:

◆ Cache Levels. Select a number
from 1 to 8. 

◆ History States. Enter the
amount of History States steps
you want to keep as undos; you
can enter up to 1,000. 

IMPORTANT History States
impact Photoshop's performance
by holding the History States using
a combination of RAM and
Scratch Disk space. The more
History States used, the more RAM
memory is required. Using an
extensive number of History States
can impact Photoshop's
performance.
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For Your Information

Setting the Cache Levels
Cache Levels are screen redraws. It's how many versions of the cur-
rent active document Photoshop saves. When you're working on
large documents, Cache Levels helps speed up the redraw function,
and makes image manipulation proceed faster. However, they are
held primarily in RAM memory, so the more Cache Levels you select,
the less RAM memory is available for other Photoshop functions. 

2

See Also
See “Installing Photoshop CS3,” on
page 2 for information on RAM and
other system needs.

3
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Enter the percentage of RAM used
in the Let Photoshop Use box.

Photoshop needs RAM memory to
work efficiently (5 times the size of
the open document). 

IMPORTANT Any setting
changes made for allocating
memory and image caching will
take place the next time you start
Photoshop. Please see the
message at the bottom of the
screen.

To override software rendering of
3D layers, select Enable 3D
Acceleration check box
(Extended) (New!).

Click OK.

IMPORTANT Never select 100
percent Memory Usage. Selecting
100 percent gives Photoshop your
entire available RAM, leaving
nothing for the operating system
or any other open programs. If you
are experiencing more than your
usual share of Photoshop crashes,
experiment with reducing memory
usage.

6
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Although Photoshop is not by definition a type setting application, such
as Adobe InDesign, it does have some very powerful type features. For
example, Adobe Photoshop allows you to output PostScript text to a
printer with a PostScript option. This way you will not need to place
Photoshop images into type intensive applications, such as InDesign or
Illustrator, just to create a few lines of text. In addition, Photoshop's
new type menu lets you see fonts as they will print or display. For
designers that use a lot of fonts, this WYSIWYG (What You See Is What
You Get) font menu is a timesaver. You can use Type preferences to
help you select the type and font options you want to use in Photoshop. 

Working with Type

Work with Type Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Type.

Select the Type options you want
to use:

◆ Use Smart Quotes. Select to
use left and right quotations.

◆ Show Asian Text Options.
Select to display Japanese,
Chinese, and Korean type
options in the Character and
Paragraph palettes.

◆ Enable Missing Glyph
Protection (New!). Select to
automatically select incorrect,
unreadable characters
between roman and non-roman
(Japanese or Cyrillic) text.

◆ Show Font Names In English.
Select to display non-Roman
fonts using their Roman names.

◆ Font Preview Size. Select to
display fonts on the menu in
small, medium, or large size.

Click OK.

IMPORTANT Photoshop uses
PostScript measuring systems to
size fonts. Therefore a 72 point
font will print 1 inch tall. Using this
lets you know how big the fonts
will appear when output to print.

4
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The Preset Manager gives you one place to manage brushes,
swatches, gradients, styles, patterns, contours, custom shapes, and
preset tools. The Preset Manager can be used to change the current
set of preset items and create new libraries of customized sets. Once a
library is loaded in the Preset Manager, you can access the library's
items in all locations the preset is available. Changes made in the
Preset Manager are global, and are applied every time you open
Photoshop. When you save a new preset, the name appears in the dia-
log box for the specific option you selected. 

3
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Managing Libraries
with the Preset
Manager

Create a New Preset

Click the Edit menu, and then click
Preset Manager.

Click the Preset Type list arrow,
and then select the options.

Click the Options list arrow, and
then select from the available
presets to add them to the current
item list.

To remove any items in a new
preset, click a thumbnail, and then
click Delete.

To reorganize their order, click and
drag the thumbnails to new
positions within the view window.

To change a preset name, click a
thumbnail, click Rename, change
the name, and then click OK.

Click a thumbnail, and then click
Save Set.

Enter a new set name, and then
select a location to store the set.

Click Save, and then click Done.9
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Did You Know?
You can save specific items in the
view window as a preset. Press
Ctrl+click (Win) or A+click (Mac) on
only those items you want in the new
set, and then click Save Set.

9
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Photoshop consists of a document surrounded by an Options bar, tool-
box, and up to 19 floating palettes. Depending on how you work, your
workspace may reflect any combination of the above. For example,
when you work with text, you would need the Character and Paragraph
palettes, but you might not need the Styles or Histogram palette. To
work efficiently, each job requires a certain organization of the work-
space. Rather than making you redesign your workspace every time
you begin a new project, Photoshop gives you ways to create and save
your own customized workspaces. 

5

2

3

Customizing the
Workspace

Create a Customized Workspace

Arrange the palettes into a specific
working order.

Click the Window button on the
Options bar (New!) or point to
Workspace on the Window menu,
and then click Save Workspace.

Type a name for the workspace. 

Select check boxes to save Palette
Locations, Keyboard Shortcuts, or
Menus.

Click Save.

Delete a Customized Workspace

Click the Window button on the
Options bar (New!) or point to
Workspace on the Window menu,
and then click Delete Workspace.

Click the Workspace list arrow, and
then click the workspace you want
to delete, or click All.

Click Delete, and then click Yes to
confirm the deletion.
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Did You Know?
You can display the Photoshop default
Workspace. Click the Window menu,
point to Workspace, and then click
Default Workspace.

PS 1.1
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For Your Information

Resetting Palettes

You can reset all Photoshop palettes back to their original configura-
tion. Click the Window menu, point to Workspace, and then click Reset
Palette Location. Photoshop resets all palettes, regardless of current
settings.
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A wise man once wrote "time is money," and Photoshop is a program
that can consume a lot of time. That's why the Photoshop application
uses shortcut keys. Shortcut keys, as their name implies, let you per-
form tasks in a shorter period of time. For example, if you want to open
a new document in Photoshop, you click the File menu, and then click
New, or you can abandon the mouse and press Ctrl+N (Win) or A+N
(Mac) to use shortcut keys. Using shortcut keys reduces the use of the
mouse and speeds up operations. In fact, a recent study in the
American Medical Journal, suggested that the use of shortcut keys
significantly cuts down on repetitive stress, and reduces instances of
carpal tunnel syndrome. Photoshop raises the bar by not only giving
you hundreds of possible shortcut keys, but also actually allowing you
to define you own shortcuts.

2

Defining Shortcut 
Keys

Create a Keyboard Shortcut

Click the Edit menu, and then click
Keyboard Shortcuts.

Click an arrow (left column) to
expand the menu that contains the
command you want to create a
shortcut.

Select an item from the commands
list.

Use the keyboard to create the
new shortcut. For example, press
Ctrl+N (Win) or A+N (Mac).

Click Accept.

Click OK.6
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Did You Know?
You can save time using shortcut
keys. According to several time and
motion studies, using shortcut keys
can actually save a computer user 1
hour out of every 8 in a work day.
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For Your Information

Working with Shortcuts
In addition to adding shortcuts, you can delete, add additional short-
cuts, and even print out a summary of shortcuts defined in
Photoshop. Shortcuts can be used for the Application and Palette
menus, as well as for your tools in the toolbox. Click the Edit menu,
click Keyboard Shortcuts, and then use the appropriate buttons,
such as Delete Shortcut, Add Shortcut, or Summarize, to perform the
tasks you want. 

PS 1.1

6

See Also
See “Keyboard Shortcuts” on page xix
for information on getting a listing of
common shortcut key assignments.
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Photoshop's pull-down menus actually contain hundreds of options
(yes, I did said hundreds). If you find navigating through menus a has-
sle, then Adobe has the answer to your problem with a customizable
user interface. In Photoshop, you have the ability to choose what menu
items appear on the pull-down menus and even colorize certain menu
items for easier visibility. For example, if your curious about all the new
features in Photoshop, you can create a drop-down menu system with
all the new features highlighted. Or, perhaps, you wish to create a
menu system that highlights all the specific tools you're planning to use
in a photo-restoration project. In fact, Photoshop includes several pre-
defined user interface sets just to get you started in the right direction.

Creating a Customized
User Interface

Use a Predefined User Interface

Click the Window menu, and then
point to Workspace.

Click one of the predefined sets,
such as: Automation, Web Design,
or What's New in CS3.

A dialog box displays asking
whether you want to apply the
new changes.

Click Yes to apply the changes.

The Photoshop menus will now
display with highlighted options
based on your selection.
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Did You Know?
You can restore menus to original set-
tings. To restore all of the Photoshop
menu settings to the original values,
click the Window menu, and then click
Reset Menus.

You can turn a text box into a slider.
You can use any text box which dis-
plays a numerical value, such as font
size, like a slider. Point to the text box,
press and hold down the Ctrl key
(which changes the cursor to a hand
with arrows), and then move the
mouse left to decrease or right to
increase the displayed number.

PS 1.1
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Create a Customized User
Interface

Click the Window menu, point to
Workspace, and then click
Keyboard Shortcuts & Menus.

Click the Menus tab.

To create a new set, based on the
current active set, click the Create
New Set button, enter a name, and
then click Save.

Click the Set list arrow, and then
select a listing of modified User
Interfaces.

Click the Menu For list arrow and
then click Application Menus or
Palette Menus with the items you
want to modify.

Click an arrow (left column) to
expand the menu that contains the
command you want to modify.

Click the Visibility icon associated
with a command to show or hide
the command.

Click the Color list arrow, and
select a color for the selected
command.

Click the Save All Changes button
to save the new customized User
Interface.

Click OK.10
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Did You Know?
You can delete a user interface set.
Click the Windows menu, point to
Workspace, click Keyboard Shortcuts
& Menus, click the Menus tab, click
the Set list arrow, click the set you
want, and then click the Delete button.
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Using Drawing Tablets

When you design on a computer, you're leav-
ing the natural world of oil, watercolor, and
canvas, for the electronic world of computer
monitors and pixels (don't worry, it's a rela-
tively painless transition). Without a doubt
there are many differences between tradi-
tional and digital design; however, it's not
necessary to abandon all aspects of the natu-
ral media world. For example, the computer
mouse has always been a problem with
designers who miss the feel and control of a
brush in their hands. Fortunately, technology
came to the rescue several years ago, with
the invention of the drawing tablet. Drawing
tablets incorporate a drawing surface, and a
brush-like drawing tool. A designer picks up
the brush and moves it across the drawing
tablet surface. In turn, the drawing tablet
interprets those movements as brush strokes.
Not only does Photoshop fully support draw-

ing tablet technology, it also interprets the
particular drawing style of the designer. For
example, pushing harder with the brush
against the drawing tablet, instructs
Photoshop to create a wider stroke, or even
to apply more color. Drawing tablets have
helped to translate the control of working
with real art brushes against canvas, into the
world of the digital designer. Of all the manu-
facturers, Wacom stands out as the leader in
drawing tablet technology. Wacom returns the
feel of designing with a brush to the digital
designer's world, and the software required
to power the tablet works seamlessly with
Photoshop and the Windows or Macintosh
operating systems. To check out what tablet
might be right for your needs, point your
browser to www.wacom.com and check out
the available options.

Drawing pen

Wacom tablet

www.wacom.com



